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Learning Objectives
•
•
•
•

Identify and understand the basic commands and functionality in Dynamo
Learn to create automated customizations to models in Dynamo
Discover how to generate models from Dynamo to Advance Steel
Learn how to update models in Advance Steel through Dynamo

Description
Dynamo software may be the name of a famous magician, but there’s a magician of a different
kind with the same name called the Dynamo Extension for Advance Steel. In this hands-on lab,
you will learn how to make a basic portal frame structure by modeling first in Dynamo a standalone
programming environment where you the designer will create it programmatically and then
preview it in real time in Advance Steel software. During this lab, we’ll introduce you to the basic
commands and functionality of the Dynamo Extension, including schemes to create sections,
assign materials, and so on. We’ll demonstrate how the model is linked and updated directly into
Advance Steel by the extension. Learn from a real-world live demonstration how the
implementation and creation of automated customizations to generate models from Dynamo to
Advance Steel will drive efficiency, resulting in productivity gains for your business.

Speakers
Rodney Page is a Designated Senior Premium Support Specialist for
Autodesk Enterprise Priority Support engaging with high profile large global
Enterprise Customers including SMEC and GHD at Autodesk. This
involves working collaboratively and proactively supporting Autodesk
software solutions and cloud-based services for 7 years with Autodesk’s
Global Engineering Enterprise Customers
Julio Alfaro has over 15 years of experience in the structural steel detailing
and fabrication industry. Previous roles and experience include designing
and detailing observation decks, structural fabricated wall panels, electrical
panels and most recently with sheet metal detailing in the sheet metal
industry. Graduate of ITT Technical Institute with an emphasis in digital
design and drafting and am well versed in Advance Steel.
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Interactive Handout
This has been designed as an interactive handout.

Autodesk Screencast
When this logo appears in the handout this indicates that there is an Autodesk Screencast
video available that captures the workflow including the commands, settings, and dialog
boxes. Go to Autodesk Screencast now. To learn more about Autodesk Screencast go to
this link Screencast FAQ. Download Autodesk Screencast.

Helpful Tip
When this logo appears in the handout this indicates that there is Helpful Tip relating to
the class.

Autodesk Knowledge Network
When this logo appears in the handout this indicates that there is an Autodesk Knowledge
Network Article relating to this class.

Autodesk University Online
When this logo appears in the handout this indicates that there is and Autodesk University
Online Session relating to this class
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Getting Started
About Dynamo Extension
The Advance Steel Application Programming Interface (API) is complex to manipulate for most
end users. For the most part, you need to be an Autodesk developer or an experienced .net
programmer to use the API and write programs. The API was developed for developers by
developers and, therefore, many Advance Steel users will find it difficult to understand, let alone
try to use. Dynamo basically allows you the end user to use the Advance Steel API through
visual programming using “nodes” and “wires” instead of text. This means that any Advance
Steel end user could use the API and create simple custom routines without having to know .net
language or without the need to hire an API programmer at extra cost.

Download & Installation
Navigate to Autodesk Account https://accounts.autodesk.com/ via. Internet Web Browser.
Select SIGN IN. For this class, we will assume the user has an Autodesk Account and access to
Product Downloads.
Use Download Now Method for Autodesk Account
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Launch Programs
Launch Advance Steel 2018 shortcut on the desktop. Resize your Advance Steel and Dynamo
programs to work uniformly side by side by selecting the Dynamo window to the left or right until
the cursor reaches the edge of the screen, then release the mouse. The window will snap into
place. Repeat the process for the Advance Steel program window. To unsnap a window, simply
click and drag the window down. Alternatively, if you have a multiple monitor set up at home or in
your office simply drag each program window onto each display.
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Test Drive Dynamo with Advance Steel
To verify that the Advance Steel and the Dynamo Extension products are installed and
functioning as designed let’s Open a sample Dynamo script called “Bridge.dyn” by selecting
from the Sample section of Dynamo front screen.
Dynamo-The Magic of a Test Drive with Advance Steel
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Quick Overview of Program Interface
Dynamo application is comprised of a series of Menus, dropdowns and searches.
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Why use the Magic of Dynamo?
Manufacturing, Infrastructure and Architectural, Engineering & Construction Designs are created
with repetition in mind. It is used as an architectural statement where repetition is simply repeating
a single element many times in a design to produce patterns and rhythms in the building design.
Repetition in design is used for economical reasons in that we create exact replicas of objects
made through industrialized processes of repetition to produce cheaper pieces for our customers
and provide efficiencies for the business producing them. We see this played out with the clothes
we wear to the utensils we eat and drink with, the planes we fly in and the cars we drive. In
Architecture, Engineering and Construction we repeat suburban home designs and layouts and
prefabricated buildings such as portal frames. This is where Dynamo comes in as a software
process to automate those repetitive design and documentation tasks for these designs
containing repetitious elements such as Portal Frames. This requires a small investment for a
larger return for your business by saving time resulting in efficiency gains, reduction in errors and
improvements in quality. Repetition doesn’t have to be boring and mundane and this introductory
class will demonstrate Advance Steel Powered by the Magic of Dynamo.

Managing Dynamo Script
As you start to create your Dynamo Script it can quickly become complex and resemble cooked
spaghetti where the Program Flow and key user inputs can be obscured due to a poor layout by
the end user There are some best practices and tips to follow when creating your script.
Photo by Rodney Page.

Alignment
After adding one or more Nodes to the Workspace, we suggest re-organizing the
location of the Nodes by selecting more than one Node and right-clicking on the
Workspace. This displays a pop up window where you can open an Align Selection
menu with justification and distribution options in X and Y direction.
Dynamo-Aligning Nodes in a Script.
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Notes
We recommend adding labels and descriptions to your nodes. Dynamo has a Notes
node with an editable text field. Notes can be added to the Workspace either via. Menu
or a keyboard shortcut.

Grouping
As the Dynamo Script grows in its size and extent it is useful to group the nodes associated
to a step in the process by highlighting and selecting a large group of nodes with a Group
and label comprising of a coloured rectangle in the background and a title. Groups can be
added either via the menu, keyboard short or a context menu in the Workspace.
Dynamo-Managing Script with Groups

A quick and effortless way to clean up your nodes is to select clean up from the file
menu or context menu.

Change the display of Connector Type by selecting the “Connector Type”
from the “Connectors” of the “View” pulldown menu.
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Lesson 1 - Creating a Column
In this lesson, we will create a steel column at a point located 1 foot in the “X” and
“Y” direction from the base point 0,0.
Dynamo-The Magic of Creating a Column in Advance Steel
a) Launch Advance Steel Desktop shortcut.
b) Create new drawing using standard template.

c) Select the Dynamo Extension from the Add-in tab of the Advance Steel ribbon or Type
‘RunDynamo” in the Command Line to launch Dynamo.
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d) Select “New” from the newly launched Dynamo Program Interface.

e) Select “Save” from File Dropdown Menu to display File Dialog Dynamo Script and as
“Column1.dyn”.

f)

Select inside the Advance Steel workspace and draw a point with the XY coordinates 1”, 1”,
which will form the start point of the column.

g) Navigate to the Dynamo Interface and Click on “Straight Beam by Start Point End Point” in
Node Advance Steel Library to display in the Workspace.
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h)

The Straight Beam our column requires a start and end, which will require a point by
coordinate. Enter “Point” in Search Field of Node Library and click on “By Coordinates”
twice to display two nodes in Workspace and drag nodes into position in Workspace.

i)

Connect “Point” output port of “Point by Coordinate” Node to “Start” input port of “Straight
Beam Node” with wire.
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j)

Connect “Point” output port of “Point by Coordinate” Node to “End” input port of “Straight
Beam Node” with wire.

k)

Set the orientation of the Straight Beam by entering “Vector” in the Search Field of the
Node Library. Click on

l)

Connect “Vector” output port of “Vector X- axis” to “v Orientation” input port with wire, which
gives the column orientation by the designated axis.
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m)

Set the location and how high the column in the workspace will be by telling Dynamo in the
script the number values for the X, Y & Z Coordinates. Enter “Number” in the Search Field
of the Node Library.
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n)
o)
p)

q)
r)

Double click on each “Number” node title and enter the X-Axis, Y-Axis & Z-Axis for each
one respectively.
Connect one “Number” output port to “X” coordinate input port of first “Point by Coordinate”
Node with wire and connect other “Number” output port to “Y” coordinate input port. Set
values to “0” for the Number nodes positions column at the x and y coordinate of 12,12.
Connect second “Number” output port to “Z” coordinate of second “Point by Coordinate”
Node input port with wire. Enter value of “120” for the Number output sets the z coordinate
of column to 120.

Enter “Number” in the Search Field of the Node Library and enter twice to add two more
number nodes to Workspace and rename titles to “X-Axis” and “Y-Axis” respectively. This
will form the X & Y coordinates of the end point of the column.
Connect one “Number” output port to “X” coordinate input port of first “Point by Coordinate”
Node with wire and connect other “Number” output port to “Y” coordinate input port. Set
values to “0” for the Number nodes positions column at the x and y coordinate of 12,12.
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s) Navigate to Advance Steel Program and zoom. Notice column created in Dynamo has
been created in Advance Steel and is positioned at X,Y Coordinate 12,12.

Page 15

Lesson 2 – Changing the profile of a Column.
In this lesson, we will change the profile of steel column from Lesson 1.
a)

Navigate to the Dynamo Interface and Click on “Beam “SetSection” Node from the
“BeamSection” sub-folder of the “Utilities” folder of the Advance Steel Library to display in
the Workspace.

b)

Add a “Code Block” node by double clicking in an empty area of the workspace.

c)

Navigate back to Advance Steel and select “Management Tools” from the Home tab of the
ribbon.
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d)

Select “Table Editor” from the “Management Tools” Dialog.

e)

Open “Installed Databases” from dialog.

f)

Enter “Master” into the search field located at the bottom of dialog and select the
“ProfileMasterTable” from the “AstorProfiles” section.
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g)

Select, right click and copy the Type Name Text called “AISC 14.1 W Shape”

h)

Navigate back to Dynamo to copy and paste the text “AISC 14.1 W Shape” with opening
and closing quotation marks into the “Code “Block node.
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i)
j)

The call section up requires a code called “#@” followed by inserting the Special Character
“§” using the <Alt> key and typing 0167 on the right-side numeric keypad.
Next enter “@#” in the Code Block. It should read “AISC 14.1 W Shape#@§@#”

k)

Navigate back to Advance Steel and select & right click and copy the Type Name
“AISC14_W”

l)

Copy and paste text into search filter located at the bottom left of dialog
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m) Select “EXT_AISC14_W_Shapes” to display list of sections sizes and select & right click
and copy the size “W8x40”.
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n)

Select and right click section size “W8x40” and paste into the end of entered text in Code
Block node.

o)

Connect “StraightBeam” output port of node to “beamElement” input port of “BeamSection”
node with wire and connect output port of Code Block node to “sectionName” input port of
“BeamSection” node.
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p)

Navigate to Advance Steel and notice the properties of the column have been updated to
the nominated size in the Dynamo Script.
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Lesson 3 - Creating a Second Column
In this Lesson, we will create a second column by copying the first one we
created in Lesson 1 and locating it 120 feet from the first created column.
Dynamo – The Magic of Creating a Second Column in Advance Steel
a)

Select all the Nodes in the Workpsace by click/drag window selection and right click to
display Context Menu and select “Create Group”.

b)

Enter “Column 1” as name of group.
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c)

Change the colour of the group by selecting and right clicking and picking the colour pink
from the context menu.
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d)

Select group and right click to display Context Menu and select “Cleanup Node Layout”.

e)

Notice the nodes have aligned and arranged in a tidy fashion.

f)

Zoom out and Copy “Column 1” Group in Dynamo Workspace by selecting the group and
enter “Ctrl “C” on the keyboard to copy the “Column 1” group and enter “Ctrl” “V” to paste
a copy of the group in the Workspace.
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g)

Change the colour of the group by selecting and right clicking and picking the colour
green from the context menu.

h)

Rename the copy of the group to “Column 2” by double clicking with the mouse on the
group label and editing.
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i)
j)

There are now two columns in the same position located 12 inches in the x and y direction.
Relocate the start point of “Column 2” 120 inches from the start point of “Column 1”. Select
the “Number” node containing the “Y” value and change to a value of “120”.

k)

Relocate the end point of “Column 2” 120 feet from the end point of “Column 1”. Select the
“Number” node containing the “Y” value and change to a value of “120”.
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l)

Click inside the Advance Steel Workspace and notice “Column 2” is now 120 inches from
“Column 1” as shown in the Dynamo Script.
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Lesson 4 - Creating a Beam
In this Lesson, we will create a beam connecting the first and second columns we created in
Lessons 1 & 2.
Dynamo – The Magic of Creating a Beam in Advance Steel
a)

Click on “Straight Beam by Start Point End Point” in Node Library to display in Workspace.

b)

Enter “Point” in Search Field of Node Library.
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c)
d)

e)
f)
g)

Click on “By Coordinates” twice to display two nodes in Workspace and drag nodes into
position in Workspace.
Connect the “Point” output port to the “Start” input port of the “Straight Beam” node.

Connect the other “Point” output port to the “End” input port of the “Straight Beam” node.
Enter “Number” in the Search Field of the Node Library.
Click on “Number” twice in Library to display two nodes in and drag nodes into position in
Workspace.
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h)

i)

Double click on the label of the “Number” node and rename by editing the text to “X”.

Repeat the previous three steps and add another two more “Number” nodes and rename
as “Y”.
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j)

Enter “Vector” into the Search Field of the Node Library.

k)
l)

Click on “Y-axis Vector” in Library to display node in Workspace.
Connect “Vector” output port of “Vector Y- axis” to “v Orientation” input port with wire,
which gives the Beam orientation by the designated axis.
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m) Connect “Number” output port to “X” coordinate input port of first “Point by Coordinate”
Node with wire and connect other “Number” output port to “Y” coordinate input port. Input
values of “12” for each “Number” node sets the x and y coordinate of column to 12,12.

n)

o)

Connect other “Number” output port to “X” coordinate input port of second “Point by
Coordinate” Node with wire and connect other “Number” output port to “Y” coordinate input
port. Input a value of “12” for the “Number” node called “X” and a value of “120” for the
“Number” node called “Y”.
Update the model in Advance Steel by selecting inside the Workspace.
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p)

q)

Chang the Orientation of the Beam by removing the Vector by X Axis and add Vector by Z
Axis. Enter “Vector” into search field of the Node Library and select Z Axis.

Beam is now orientated in the desired direction.
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r)
s)

Enter “Number” in the Search Field of the Node Library.
Click on “Number” in Library to display node and drag into position in Workspace.
To add notes to the Workspace of the Dynamo Visual Script select “Create Note”
from “Edit” Dropdown Menu. Double click and Edit the Note accordingly and click
accept
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t)

Double click on the label of the “Number” node and rename by editing the text to “Z”.

u)

Connect “Number” output port to “Z” coordinate input port of first “Point by Coordinate”
Node with first wire and a second wire connect “Number” output port to other “Y”
coordinate input port. Set value of “120” for “Number” node.
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v)

Click inside the Advance Steel Workspace and notice the Beam’s midpoint at each end has
been generate connecting “Column 1” and “Column 2” as shown in the Dynamo Script.
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w) Select the Beam and the Properties and change the Positioning of the Beam from the midpoint of
the web and flanges to the midpoint of the web and top flange.
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Create Connections
a)
b)

Add base plates to columns by selecting “Base plate from the “Connection Vault Tool
Palette. Select the column and return to apply base plate connection.
Repeat the previous step for the other column.
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c)
d)
e)

Add Clip Angle connection to the beam and column by clicking on “Platform Beam” from
the “Connection Vault Tool Palette” and selecting “Clip Angle”.
Select the Column and enter following by the beam and enter to add the connection.
Repeat previous steps to add connection to the other end of beam and second column.
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f)

Navigate back to the Dynamo Workspace and window select the nodes for the Beam and
right click and select Group from context menu.
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g)

Rename the Group by entering the text “Beam 1” into the Group title field.

Take a snapshot of the Dynamo Visual Script by selecting the “Camera” icon located at
the top right corner above the Workspace. Select this icon and it will immediately open
the File Dialog box ready to add the name of your exported image.
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Lesson 5 - Creating Portal Frame Building
In this Lesson, we will create a Portal Frame Building.
Dynamo – The Magic of Creating a Portal Frame Building in Advance Steel

Set-out Portal Frame Building Parameters
a) Enter “Number” in the Search Field of the Node Library.

b) Click on “Number” three times in Library to display three nodes and drag into position in
Workspace.
c) Rename first “Number” node by double clicking title and entering “Building Length” in text
field and select “Accept” and enter the value of 200 inches into Number node.

d) Rename second “Number” node by double clicking title and
entering “Building Width” in text field and enter the value of 110
inches into the Number node.
e) Rename third “Number” node by double clicking title and entering
“Number of Bays” in text field an enter the value of 5 into
“Number of Bays” Number node.
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Set-out Portal Frame Column Nodes
a)

b)
c)

d)

Enter “Divides” in the Search Field of the Node Library.

Click on “Divides” in Library to display Divide node and drag into position in Workspace.
Lock the display for the result.
Connect the “Building Length” Number node to the “X’ Input port of the Divide node with
wire.

Connect the “Number of Bays” Number node to the “Y’ Input port of the Divide node with
wire. This divides the Building Length value of 200 by 5 bays giving a result of 40 inches.
The Dynamo Software automatically produces the calculation.
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e)

Enter “Range” in the Search Field of the Node Library.

f)
g)

Click on “Range” in Library to display Range node and drag into position in Workspace.
The Start Input port is 0,0 and leave unchanged.

h)

Connect “Building Length” number node output port to the End input port of the Range
Node with wire.
Connect variable output port of Division node to step input port of Range node.
Enter “Point” in the Search Field of the Node Library.

i)
j)
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Click on “Point by Coordinate” in Library to display Point by Coordinate node and drag into
position in Workspace.
l) X input port of Point by Coordinate remains unchanged with 0,0.
m) Connect Seq output port to the Y input port of Point by Coordinate node with wire.
k)

n) Notice our X value is set at 0,0 while the Y value is set to increments of 40 inches.
o) Select Point by Coordinate node and enter ctrl C on keyboard to copy and Ctrl V to
paste in Workspace.
p) Connect the “Building Width” output port of the Number node to the X input port of the Point
by Coordinate node you just copied.
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q)
r)

s)

Notice a second set of points are displayed 110 apart from the first set at 0.0 spaced at
increments of 40 inches.
Create a wall height by copying one of the Number nodes using keyboard shortcuts ctrl C
and ctrl V. Rename the copied node title by double clicking and enter “Wall Height” into text
field. Enter a value of 90 inches into data of node.

Copy the first Point by Coordinate by selecting the node and copy and paste using
keyboard shortcuts ctrl C and ctrl V into the Workspace.
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t)

Connect the Wall Height Number node output port to Z input port of the recently copied
Point by Coordinate. Notice a second set of points are displayed 90 inches above the first
set.
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u)

Repeat again by copying the Second Point by Coordinate by selecting the node and copy
and paste using keyboard shortcuts ctrl C and ctrl V into the Workspace.
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v)

Connect the Wall Height Number node output port to Z input port of the recently copied
Point by Coordinate. Notice another set of points are displayed 90 inches above the second
set.
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Set-out Portal Frame Apex Nodes
a)

b)

Create the apex of the ridge line of the portal frame by selecting the Divides node and
copying and pasting in the Workspace using keyboard shortcuts. Remove the wires.

Copy the first Point by Coordinate by selecting the node and copy and paste using
keyboard shortcuts ctrl C and ctrl V into the Workspace. Rename node title “Point by
Coordinate Roof”
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c)

Add a ‘Code Block” node by double clicking in an empty area of the Workspace and enter a
value of ‘2”.

d)

Connect the Building Width node output port to the X input port of the Divides node with
wire.
Connect the Code Block node output port to the Y input port of the Divides node with wire.

e)
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f)
g)
h)

Connect the Var output port of the Division node to the X input port of the Point by
Coordinate Roof node with wire.
Connect the seq output port of the Range Node to the Y input port of the Point by
Coordinate Roof node with wire. Notice a set of points is displayed midway between the
outer set-out points of the portal frame.
Copy Building Length Number node and paste into Workspace and rename Roof Height.
Enter a value of 110 inches.
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i)

Connect the output port of the Roof Height Number node to the X input port of the Point by
Coordinates Roof node. Notice that ridge points are now set to 110 inches in the Z
direction.
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Connect Straight Beams to Nodes
a)

Select “Straight Beam” node from the Beam section of the Node Library.

b)

Connect the Point output port of the first Point by Coordinates node to the “start” input port
of the Straight Beam node.

c)

Connect the Point output port of the third Point by Coordinates node to the “end” input port
of the Straight Beam node.
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d)

Enter “Vector” in the Search Field of the Node Library.

e)

Select “Z” axis vector node to set orientation of column/beam by connecting Vector output
port to V Orientation input port of Point by Coordinate Node.

f)

Navigate to the Advance Steel Workspace and notice there are a set of columns
displayed.
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g)

Copy and paste the Straight Beam Node into workspace by using keyboard shortcuts and
disconnect X and Y wires by deleting and keep Vector orientation.
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h)

Connect the Point output port of the Point by Coordinate node to the start input port of the
Straight Beam node.

i)

Connect the Point output port of the Point by Coordinate node to the end input port of the
Straight Beam Node.
Navigate to the Advance Steel Workspace and notice there are a second set of columns
displayed for the portal frame.

j)
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k)

Copy and paste into the Workspace using keyboard shortcuts the Straight Beam node and
delete the wires connecting to the start and end input ports.
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l)

m)

Connect the Point output port of the Point by Coordinates nodes to the start input port of
the Straight Beam node.

Connect the Point outport port of the Point by Coordinates Roof node to the end input port
of the Straight Beam node.
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n)
o)

p)
q)

Copy and paste into the Workspace using keyboard shortcuts the Straight Beam node and
delete the wires connecting to the start and end input ports.
Connect the Point output port of the Point by Coordinates nodes to the start input port of
the Straight Beam node.

Connect the Point outport port of the Point by Coordinates Roof node to the end input port
of the Straight Beam node.
The Portal Frame is displayed in the Dynamo Workspace. Navigate to the Advance Steel
and notice the Portal Frame Building is displayed in the Workspace.
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Create Portal Frame Connections
a)

Select “Connection Vault” from the Home tab of the ribbon to display the Palette in the
Advance Steel Workspace.

b)

Create a Baseplate Connection by selecting “Base plate” from Tool Palette and selecting
first column.
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c)

Select “Advance Steel Tool Palette” from the Home tab of the ribbon to display the Palette
in the Advance Steel Workspace.

d)

Select “Create by Template Multiple” from Advance Steel Tool Palette. Select the source
joint, that is the base plate and enter.
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e)

Select all the columns to be the recipient of the base plate source joint and enter. The
baseplates are applied to all the columns.
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f)
g)

Create an Apex Haunch Connection by selecting “Apex haunch” from the “Connection
Vault Tool Palette”.
Select the first rafter and enter followed by the second rafter and enter.
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h)

Select “Create by Template Multiple” from Advance Steel Tool Palette. Select the source
joint, that is the Apex Haunch and enter.

i)

Select the first set of rafters for the recipient of the source joint and enter and then select
the connecting second set of rafters followed by return.
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j)

Navigate back to the Dynamo Workspace and edit the Building Width by clicking on the 110
inches value and changing to a value of 200 inches. Navigate back to the Advance Steel
Workspace and notice the width has been updated according to the changes in the
Dynamo Script.
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k)

Create a “Knee of Frame bolted with haunch Connection” by selecting from the
“Connection Vault Tool Palette” from the “Column-Beam” section.

l)

Select the Column followed by enter and then select the Rafter followed by enter.
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m) Select “Create by Template Multiple” from Advance Steel Tool Palette. Select the source
joint, that is the Knee of Frame bolted with haunch Connection and enter.

n)

Select the first set of columns for the recipient of the source joint and enter and then select
the connecting second set of rafters followed by return.
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o)

Navigate back to the Dynamo Workspace and edit the Building Length by clicking on the
200 inches value and changing to a value of 500 inches. Navigate back to the Advance
Steel Workspace and notice the width has been updated according to the changes in the
Dynamo Script.

Notice the steel connections adapt to the changes made in the Dynamo Script.
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Useful Links & Resources
The Dynamo Primer
A comprehensive guide to visual programming in Autodesk Dynamo Studio.
Dynamo Video Tutorials
An introductory resource for beginners and a long-term reference.
The Dynamo Dictionary
A searchable database for Dynamo functionality.
Dynamo Website
Dynamo Discussion Forum
The Dynamo Extension for Advance Steel
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